Contents

Release Notes for Cisco Unified Messaging
Release 8.0(1) with IBM Lotus Sametime

Published August 25, 2010

These release notes contain requirements, instructions for downloading, installing, and configuring
software, and information on new and changed support, and limitations and restrictions for Cisco
Unified Messaging Release 8.0(1) with IBM Lotus Sametime.

e Introduction, page 1

e System Requirements, page 2

e Related Documentation, page 3

e New and Changed Requirements and Support—Release 8.0(1), page 3
¢ New and Changed Functionality—Release 8.0(1), page 4

e Installation and Upgrade Information, page 4

e Limitations and Restrictions, page 13

e (aveats, page 15

e Troubleshooting Information, page 15

¢ Obtaining Documentation and Submitting a Service Request, page 16

Introduction

st]oan]n,
CISCO.

Cisco Unified Messaging with IBM Lotus Sametime allows users to view and play Cisco Unity or
Cisco Unity Connection voice messages directly from their Sametime client application.

In addition, IBM Lotus Notes versions 8.0.1 and later integrate Sametime features to achieve the
following features:

e Sametime shows up in a pane within the Notes client.
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Bl System Requirements

e The native capabilities of Sametime—as well as Cisco Unified Messaging with Lotus Sametime
features—can be accessed from within Notes.

System Requirements

Before installing Cisco Unified Messaging with IBM Lotus Sametime, user workstations must meet the
following minimum requirements:

e A supported operating system—see “Client Platforms” in the following section, “Compatibility
Information.”

e 512 MB of RAM.
e 20 MB of free disk space.
¢ One of the following applications:
— IBM Lotus Notes version 8.0.1 or later (including integrated Sametime features)

— IBM Lotus Sametime version 8.0.1 or later

Compatibility Information

Cisco Unified Messaging with IBM Lotus Sametime is supported for use with the following:

Cisco Unified Messaging Systems

e Cisco Unity
— Version 8.0 with Microsoft Exchange
— Version 7.0 with IBM Lotus Domino
— Version 7.0 with Microsoft Exchange
— Version 5.0 with IBM Lotus Domino
— Version 5.0 with Microsoft Exchange
e Cisco Unity Connection
- Version 8.0
- Version 7.x

— Version 2.1

Client Platforms

e Apple
- Mac OS X 10.6.x
- Mac OS X 10.5.x
- Mac OS X 10.4.x

e Microsoft
- Windows 7 Enterprise, Professional, and Ultimate editions
— Windows Vista Business and Enterprise editions (MSDN version is not supported.)

— Windows XP (Service Pack 2 and later)
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e Novell
— SUSE Linux Enterprise Desktop version 10
- Linux Desktop version 9

e Red Hat Enterprise Linux version 4

IBM Lotus Clients
— IBM Lotus Notes version 8.0.1 and later (including integrated Sametime features)

— IBM Lotus Sametime version 8.0.1 and later

~

Note If you are using secure messaging, Lotus Sametime versions 8.0.1, 8.0.2,and 8.5 require
hotfixes; version 8.5.1 does not. (See also the “Applying IBM Hotfixes for Lotus Sametime
8.0.1., 8.0.2, or 8.5 (Secure Messaging Only)” section on page 6.)

Determining the Software Version

To Determine the Cisco Unified Messaging with IBM Lotus Sametime Version in Use

Step 1 From the File menu, select Preferences.
Step2  In the left pane, expand the Cisco tab.
Step 3 Under Cisco, select Voicemail.

The Cisco Unified Messaging with Lotus Sametime version is displayed underneath the “Voicemail”
label at the top of the page.

Related Documentation

The User Guide for Cisco Unified Messaging Release 8.x with IBM Lotus Sametime is available at
http://www.cisco.com/en/US/products/ps9830/products_user_guide_list.html.

New and Changed Requirements and Support—Release 8.0(1)

This section contains information about new and changed requirements and support in the 8.0(1) time
frame only.

(For information on new and changed requirements and support in earlier versions of Cisco Unified
Messaging with IBM Lotus Sametime, see the applicable release notes at
http://www.cisco.com/en/US/products/ps9830/prod_release_notes_list.html.)

Cisco Unified Messaging Systems

With this release, the following Cisco unified messaging systems have been added to the list of supported
systems for use with Cisco Unified Messaging with Lotus Sametime:
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e Cisco Unity Connection version 8.0

e Cisco Unity version 8.0 with Microsoft Exchange

IBM Lotus Client Applications

With this release, the following IBM Lotus client applications have been added to the list of supported
applications for use with Cisco Unified Messaging with Lotus Sametime:

e IBM Lotus Notes versions 8.5.1 (including integrated Sametime features)

e IBM Lotus Sametime versions 8.5 and 8.5.1

Operating Systems on User Workstations

With this release, the following operating systems have been added to the list of supported operating
systems for use on user workstations with Cisco Unified Messaging with Lotus Sametime:

e Apple Mac OS X 10.6.x
e Windows 7:
- Enterprise Edition
- Professional Edition

— Ultimate Edition

New and Changed Functionality—Release 8.0(1)

There is no new or changed functionality in this release.

(For information on new and changed functionality in earlier versions of Cisco Unified Messaging with
IBM Lotus Sametime, see the applicable release notes at
http://www.cisco.com/en/US/products/ps9830/prod_release_notes_list.html.)

Installation and Upgrade Information

e Downloading Cisco Unified Messaging 8.0(1) with IBM Lotus Sametime Software, page 4

e Applying IBM Hotfixes for Lotus Sametime 8.0.1., 8.0.2, or 8.5 (Secure Messaging Only), page 6
e Upgrading to Cisco Unified Messaging 8.0(1) with IBM Lotus Sametime, page 6

¢ Installing Cisco Unified Messaging 8.0(1) with IBM Lotus Sametime, page 7

e Configuring Cisco Unified Messaging 8.0(1) with IBM Lotus Sametime, page 8

Downloading Cisco Unified Messaging 8.0(1) with IBM Lotus Sametime
Software

Do the following two procedures in the order listed.
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Step 1

Step 2

Step 3

Step 4

Step 5
Step 6
Step 7
Step 8

Step 9

Step 1

Step 2

Installation and Upgrade Information

To Download Cisco Unified Messaging 8.0(1) with IBM Lotus Sametime

On the web server that is going to host the update site, create a folder to hold the Cisco Unified
Messaging with IBM Lotus Sametime files.

On a computer with a high-speed Internet connection, go to the Unified Communications Plug-ins for
IBM Lotus Sametime Software software download page at
http://tools.cisco.com/support/downloads/go/Redirect.x 7mdfid=282224966.

~

Note  To access the software download page, you must be signed in to Cisco.com as a registered user.

On the Select a Release page, expand Latest Releases, then select 8.0(1b). The download button appears
on the right side of the page.

Confirm that the computer you are using has sufficient hard-disk space for the downloaded file. (The
download file size appears in the download description.)

Download the file Cisco_Plugins_8.0.1b.zip to the folder you created in Step 1.
Follow the on-screen prompts to complete the download.
Open the folder you created in Step 1.

From the Cisco_Plugins_8.0.1b.zip file, extract the CiscoUMWithLotusST_8.0.1.1012.zip file by
using the application appropriate for the operating system.

Open the CiscoUMWithLotusST_8.0.1.1012.zip\UpdateSite directory that was created from the
extracted file.

When extracted, the directory structure for Cisco Unified Messaging with IBM Lotus Sametime looks
like this:

- features
- plugins
- web
index.html
site.xml

To Extract the Cisco Unified Communications with IBM Lotus Sametime Configuration Tool

Go to the directory where you downloaded the Cisco_Plugins_8.0.1b.zip file in the “To Download Cisco
Unified Messaging 8.0(1) with IBM Lotus Sametime” procedure on page 5.

From the Cisco_Plugins_8.0.1b.zip file, extract the CiscoCfg-8.0.1.107.zip file by using the application
appropriate for the operating system.

When extracted, the directory structure for the Cisco Unified Communications with IBM Lotus
Sametime Configuration Tool looks like this:

- ciscocfg
- templates
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Applying IBM Hotfixes for Lotus Sametime 8.0.1., 8.0.2, or 8.5 (Secure
Messaging Only)

~

Note

Step 1

Step 2

Step 3

Step 4
Step 5

The IBM hotfixes apply only to Lotus Sametime 8.0.1, 8.0.2, and 8.5.

Do the procedure in this section only when secure messaging is configured.

To Apply IBM Hotfixes for Lotus Sametime 8.0.1, 8.0.2, or 8.5 (Secure Messaging Only)

Go to the IBM website and obtain the required hotfixes:
http://www.ibm.com/support/docview.wss?rs=899&uid=swg21414050.

Extract the hotfix files by using the application appropriate for the operating system.
When extracted, the directory structure for the IBM hotfixes looks like this:

- features
- plugins
site.xml

Copy the files in the features directory to the UpdateSite\features directory.

If the client platforms at the site do not all use the same operating system, we recommend that you create
a separate UpdateSite directory for each operating system and copy the IBM hotfixes for each operating
system into the applicable UpdateSite directory.

Copy the files in the plugins directory to the UpdateSite\plugins directory.

Replace the site.xml file in the UpdateSite directory with the extracted site.xml file.

A

Caution  You must replace the site.xml file before configuring Cisco Unified Messaging with Lotus
Sametime by using the Configuration Tool. Otherwise, the IBM hotfixes for secure messaging
will not be available for installation.

Upgrading to Cisco Unified Messaging 8.0(1) with IBM Lotus Sametime

There is no separate upgrade process—you install the new version of the plug-in in the same way you
installed the previous version. See the next section, “Installing Cisco Unified Messaging 8.0(1) with
IBM Lotus Sametime.”

You do not need to uninstall a previous version. The update manager in Sametime handles it.
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Installation and Upgrade Information

Installing Cisco Unified Messaging 8.0(1) with IBM Lotus Sametime

Note

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

Step 7

Step 8
Step 9
Step 10
Step 11
Step 12

There are two ways in which to install the plug-in on user workstations:

e Automatic push update—See the IBM Lotus Sametime documentation for information on setting
up an automatic push update. We recommend using this method.

(After the push update has been set up, continue with the “Configuring Cisco Unified Messaging
8.0(1) with IBM Lotus Sametime” section on page 8.)

~

Note IBM Lotus Notes does not support an automatic push update, but you can configure your
installation to use a Notes widget to create similar behavior. You must first run the Cisco Unified
Communications with IBM Lotus Sametime Configuration Tool and then follow the instructions
at
http://publib.boulder.ibm.com/infocenter/domhelp/v8r0/topic/com.ibm.help.domino.admin85.d
oc/H_CLIENT_MGMNT_OVER .html.

e Manual installation—Do the “To Manually Install the Cisco Unified Messaging with IBM Lotus
Sametime Plug-in on a User Workstation” procedure in this section.

(After the software has been installed, continue with the “Configuring Cisco Unified Messaging
8.0(1) with IBM Lotus Sametime” section on page 8.)

After the plug-in is installed, users may be required to enter their Cisco Unity or Cisco Unity Connection
account information in their IBM Lotus Sametime client application. Instructions are provided in the
User Guide for Cisco Unified Messaging with IBM Lotus Sametime Release 8.x, available on Cisco.com
at http://www.cisco.com/en/US/products/ps9830/products_user_guide_list.html.

To Manually Install the Cisco Unified Messaging with IBM Lotus Sametime Plug-in on a User Workstation

Start the IBM Lotus Sametime client application.
From the Tools menu, select Plug-ins > Install Plug-ins.

In the Install/Update wizard, on the Feature Updates page, select Search for New Features to Install
and select Next.

On the Update Sites to Visit page, select Add Remote Location.
In the New Update Site dialog box, in the Name field, enter Cisco Voicemail.

In the URL field, enter the URL of the update site that hosts the Cisco Unified Messaging with IBM
Lotus Sametime plug-in and select OK.

On the Update Sites to Visit page, select Finish.

The Updates window opens with Cisco Voicemail listed as a feature to install.
Select Cisco Voicemail.

If there is an IBM hotfix available, select the IBM hotfix.

Select Next.

Select I Accept the Terms of the License Agreement, and select Next.

If a feature verification warning appears, select Install All.
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Step 13

Select Yes to restart the IBM Lotus Sametime client application.

Configuring Cisco Unified Messaging 8.0(1) with IBM Lotus Sametime

Step 1

Step 2
Step 3
Step 4

Step 5
Step 6

In this section, you configure the Cisco Unified Messaging with IBM Lotus Sametime plug-in for all
users who will use it.

You can use the Cisco Unified Communications with IBM Lotus Sametime Configuration Tool for
updating user configuration information after the plug-in has been installed.

For configuration changes to take effect, either set up Sametime to update users automatically by using
a push update, or instruct users to update the plug-in from their Sametime client.

This section contains two procedures:
e To Configure Cisco Unified Messaging with IBM Lotus Sametime by Using the Configuration Tool

e To Manually Configure Cisco Unified Messaging with IBM Lotus Sametime on a User Workstation

To Configure Cisco Unified Messaging with IBM Lotus Sametime by Using the Configuration Tool

Go to directory that was created in the “To Download Cisco Unified Messaging 8.0(1) with IBM Lotus
Sametime” procedure on page 5.

Go to the ciscocfg directory.
Double-click ciscocfg.exe.

In the Choose an Update dialog box, in the Directory field, enter the path of the UpdateSite directory
that was created in the “To Download Cisco Unified Messaging 8.0(1) with IBM Lotus Sametime”
procedure on page 5.

Select OK.

In the Cisco Unified Communications with IBM Lotus Sametime Configuration Tool window, select the
LDAP tab and enter values in the applicable fields. The fields are described in Table 1.

~

Note  Configuration of LDAP is optional. However, choosing not to use LDAP may result in some
diminished unified messaging functionality. For example, Cisco Unified Messaging with Lotus
Sametime uses LDAP to map phone numbers from voice messages to Sametime contacts.
Without LDAP properly configured, phone numbers or names may display in the Name column
rather than Sametime contacts.

Table 1 Fields on the LDAP Tab

Name Description

Directory Server Settings

Server Enter the name or IP address of the LDAP server.

Port Enter the number of the port used to communicate with the LDAP
server.
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Table 1 Fields on the LDAP Tab (continued)
Name Description
Search Base Enter the base (or root) of the directory service in which to search

for names. The value must match the one configured on Sametime
server. If LDAP is used for the directory service, you can derive
the setting directly from there. If Domino is used instead, find the
equivalent search base on its LDAP interface.

Display Name Attribute Enter the LDAP attribute that is used as the display name for the
caller.

Attribute for Lookup in Sametime |Enter the LDAP attribute that is used to search for the caller in

Sametime.
Authentication Required Check this option if authentication is required by the server.
Authentication Credentials
Distinguished Name (When authentication is enabled) Enter the distinguished name

that is used to authenticate with the directory service.

Password (When authentication is enabled) Enter the password that is used
to authenticate with the directory service.

Directory Usage

Non-default Community Access Enable non-default communities to use directory services to
extend the functions to pilot communities, for example:

e Retrieve phone numbers to populate their contacts
e Show phone status for their contacts

Only one set of users data can be used. You can have two
communities, but of the same global set of users. If the Sametime
server for the non-default communities uses the same LDAP
server as the default community, then identical functionality can
be extended to contacts in those communities.

Select the applicable setting:

¢ Disable—Select this option so that non-default communities
are unable to use the directory service.

e Enable for All Communities—Select this option so that all
non-default communities are allowed to use the directory
service.

e Enable for Configured Communities—Select this option
so that only communities listed in the Community List field
are allowed to use the directory service.

Community List (When Enable for Configured Communities is selected above)
Enter the list of communities (Sametime host name or IP
address), separated by commas, that you want to allow access to
the directory service.
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Table 1 Fields on the LDAP Tab (continued)

Name Description

Directory Type for Sametime Server

Directory Type Enter the applicable settings:

LDAP—Select this option if the IBM Lotus Sametime server
uses an LDAP server for directory service.

If IBM Lotus Sametime uses an LDAP attribute for the internal
user ID, check the Use Attribute as Internal ID of Sametime
User option and enter the name of the LDAP attribute.

Domino—Select this option if the IBM Lotus Sametime server
uses IBM Lotus Domino for the directory service.

Refer to IBM Lotus Sametime documentation for additional
information.

Dialing Rules Files

Application Dial Rules If you will use Application Dial Rules, enter the location of the
dial rules file. You can obtain Application Dial Rules from Cisco
Unified Communications Manager Administration by navigating
to the Call Routing area.

Application Dial Rules automatically strip numbers from or add
numbers to telephone numbers that Sametime Connect dials. For
example, the dialing rules automatically add the digit 9 in front of
a 7-digit telephone number to provide access to an outside line.

Note A file template is available in the templates directory
where you extracted the Cisco Unified Communications
with IBM Lotus Sametime Configuration Tool.

This field applies only when Cisco Phone Control and
Presence is configured with Cisco Unified Messaging
with Lotus Sametime.

Directory Lookup Dial Rules If you will use Directory Lookup Dial Rules, enter the location of
the dial rules file. You can obtain Directory Lookup Dial Rules
from Cisco Unified Communications Manager Administration.
Navigate to the Call Routing area.

Directory Lookup Dial Rule transform caller identification
numbers into numbers that can be looked up in the directory. For
example, the dialing rules can automatically add +140852 to
5-digit numbers beginning with 5, so that the number 56666
becomes +14085256666.

Note A file template is available in the templates directory
where you extracted the Cisco Unified Communications
with IBM Lotus Sametime Configuration Tool.

Step7  On the File menu in the Configuration Tool window, select Save.

Step8 Inthe window, select the Voicemail tab and enter values in the applicable fields. The fields are described
in Table 2.
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Fields that remain empty do not overwrite the Cisco Unified Messaging with Lotus Sametime
configuration on the client, but fields with values will overwrite the Cisco Unified Messaging with Lotus
Sametime configuration when an updated feature is installed on the client workstation.

Table 2 Fields on the Voicemail Tab

Name Description

Mail Store Connection Settings

Server Enter the applicable setting:

e For Cisco Unity, enter the name or IP address of the
Exchange or IBM Lotus Domino server.

¢ For Cisco Unity Connection, enter the name or IP address of
the Connection server.

Port Enter the number of the port used to communicate with the mail
store.

Note Cisco Unity Connection provides a port that enables
license-free IMAP connections. To use this port, enter
7993, and check the Use Encrypted Connection check
box.

Use Encrypted Connection Check this check box to use an encrypted connection to
communicate with the mail store.

Use Sametime Credentials Check this check box if the credentials for logging in users to
IBM Lotus Sametime are the same as the credentials for
connecting to the voicemail system.

Read Only Check this check box to prevent the user from changing these
settings.

Poll Interval If the server supports IMAP IDLE, the setting in this field is
ignored.

If the server does not support IMAP IDLE, enter the time, in
seconds, that each client waits before checking for new voice

messages.

Mail Store Folder Settings

Inbox Folder Enter the name of the voicemail folder in the IMAP store.
Move Deleted Voicemail to a Check this check box if the mail store has a folder for deleted
Separate Folder messages that is separate from the Inbox folder.

Trash Folder If the mail store has a separate folder for deleted messages, enter

the name of the folder for deleted messages.

System Settings

Enable Connection to Voicemail If secure messaging is configured on Cisco Unity, check this
Web Service Server check box to enable the Voicemail Web Service server.

If secure messaging is configured on Cisco Unity Connection, do
not check this check box.

Use Mail Store Server as Voicemail |(When the Voicemail Web Service server is enabled) Check this
Web Service Server check box if the Voicemail Web Service server is on the mail store
server that is entered in the Servers field under Mail Store
Connection Settings.
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Table 2 Fields on the Voicemail Tab (continued)
Name Description
Server (When the Voicemail Web Service server is enabled) If the Use

Mail Store Server as Voicemail Web Service Server check box is
not checked, enter the name or IP address of the Voicemail Web
Service server.

Protocol (When the Voicemail Web Service server is enabled) Select the
applicable setting:

e HTTP—Select this option if message security is not used.

e HTTPS—Select this option if message security is used.

Port (When the Voicemail Web Service server is enabled) Enter the
number of the port used to communicate with the Cisco Unity
server.

LDAP Attributes

User ID Enter the LDAP user attribute that contains the user ID in voice
messages so that a directory search can find and display the user
name.

Phone Numbers Enter the LDAP phone attributes that contain the caller ID in

voice messages so that a directory search can replace the phone
number with the caller name on voicemail.

Voicemail Player Settings

Rewind Interval Enter the time, in seconds, that a message will rewind when the
Rewind button on the Voicemail player is pressed.

Skip Forward Interval Enter the time, in seconds, that a message will skip forward when
the Skip Ahead button on the Voicemail player is pressed.

Logging

Enable Detailed Logging Check this check box to enable detailed logging.

A

Caution  Enable detailed logging only for troubleshooting.
Otherwise, the logging will impact the system
performance.

Step9  On the File menu in the Configuration Tool window, select Save All.

Step10  On the File menu in the Configuration Tool window, select Exit.

A

Caution  Confirm that you have saved your changes in the Cisco Unified Communications with IBM
Lotus Sametime Configuration Tool window. Otherwise, all unsaved changes will be lost
when you close the window.

Step 11 For configuration changes to take effect, either set up IBM Lotus Sametime to automatically update users
by using a push update, or instruct users to update the plug-in from their IBM Lotus Sametime client.
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Step 2
Step 3

Step 4

Step 5

Step 6

Limitations and Restrictions

The following procedure requires administrator-provided information.

To Manually Configure Cisco Unified Messaging with IBM Lotus Sametime on a User Workstation

In IBM Lotus Sametime Connect, from the File menu, select Preferences.
In the Preferences window, in the left pane, expand Cisco and select Voicemail.

Under Account, if the following fields are blank, enter the applicable settings as your administrator
instructs. Otherwise, skip to Step 4.

a. In the User ID field, enter your user ID.

b. In the Password field, enter your password.

c. In the Server field, enter the server name or the IP address of the mail store.

d. In the Port field, enter the port number used to communicate with the mail store.
e. Check or uncheck the Use Secure Connection check box.

If you want Sametime to display an icon indicating unheard voice messages, check the Show Global
Message Waiting Indicator check box.

If you want Sametime to maintain a log to assist in troubleshooting issues, check the Enable Detailed
Logging check box.

Select OK to accept the settings and to close the Preferences window.

Limitations and Restrictions

IBM Lotus Notes Displays Dates In U.S. English Format

IBM Lotus Notes displays dates only in the U.S. English format when any English language is selected.

IBM Lotus Sametime Displays Dates In U.S. English Format

If users want IBM Lotus Sametime to display the date in a format for English other than U.S. English,
do the procedure in this section.

The procedure applies only to IBM Lotus Sametime installed on the Windows and Mac operating
systems. This workaround does not apply to IBM Lotus Sametime installed on a Linux operating system,
or to IBM Lotus Notes.
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To Configure IBM Lotus Sametime to Display the Date in a Non-U.S. English Format

Step 1 On the user workstation, go to the applicable directory—depending on the operating system—and open
the file:

Windows | Documents and Settings\<user>\Application Data\Lotus\Sametime\.config\
rcpinstall.properties

Mac Users/<user>/Lotus/Sametime/.config/rcpinstall.properties

Step2  In the file that you opened in Step 1, make the applicable change:

Windows |Change the line com.ibm.rcp.core.locale=en to one of the following:
e For Canada, enter com.ibm.rcp.core.locale=en_CA.
e For Ireland, enter com.ibm.rcp.core.locale=en_IE.

e For United Kingdom, enter com.ibm.rcp.core.locale=en_GB.

Mac At the end of the file, add the applicable line:
e For Canada, enter com.ibm.rcp.core.locale=en_CA.

e For Ireland, enter com.ibm.rcp.core.locale=en_IE.

¢ For United Kingdom, enter com.ibm.rcp.core.locale=en_GB.

Step3  Save and close the file.

G.729a Encoded Voice Messages Cannot Be Played

Cisco Unified Messaging with IBM Lotus Sametime plays only voice messages encoded with G.711.

MWI on Phone Does Not Change to Reflect Message State

For environments with Cisco Unity and IBM Lotus Domino as the message server, IBM Lotus Sametime
does not communicate changed message states so that Cisco Unity can change the message waiting
indicator (MWI) on the phone. For example, the new-message light on the phone will not turn off after
the message is played from IBM Lotus Sametime.

Deleted Messages Folder Is Not Supported If the Mail Store Does Not Support
UIDPLUS

If the mail store does not support UIDPLUS, Cisco Unified Messaging with IBM Lotus Sametime does
not support a folder for deleted messages that is separate from the Inbox folder. Voice messages in a
folder for deleted messages on this message store has the following limitations:

e Moving voice messages to a folder for deleted messages does not turn off MWISs.
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Caveats W

e IBM Lotus Sametime Connect shows the deleted voice messages by using the Deleted filter, but the
phone user interface (TUI) lists the deleted voice messages as saved messages.

e Voice messages in the folder for deleted messages cannot be deleted or purged.

Update Sites

Older versions of IBM Lotus Sametime did not support simultaneous updates from multiple update sites.
Selecting more than one update site and trying to install a feature caused a NullPointerException. This
may have been fixed in newer versions.

Caveats

There were no Severity 1, 2, or 3 resolved caveats in Cisco Unified Messaging with Lotus Sametime
version 8.0(1).

You can find the latest caveat information for Cisco Unified Messaging with Lotus Sametime version
8.0(1) by using Bug Toolkit, an online tool available for customers to query defects according to their
own needs.

Bug Toolkit is available at www.cisco.com/go/bugs. Fill in your query parameters by using the custom
settings in the Advanced Settings option.

Note  To access Bug Toolkit, you must be signed in to Cisco.com as a registered user.

Release notes for all versions of Cisco Unified Messaging with Lotus Sametime are available at
http://www.cisco.com/en/US/products/ps9830/prod_release_notes_list.html.

Troubleshooting Information

e Status Bar in Cisco Voicemail Application Panel, page 15
¢ Creating a Problem Report, page 15

e User Unable to Play Voice Messages Because of Port Conflicts, page 16

Status Bar in Cisco Voicemail Application Panel

The status bar at the bottom of the Cisco Voicemail application panel indicates when the user is
successfully connected to Cisco Unity or to Cisco Unity Connection. Any error messages appear as
hypertext links, which users can select to show information about the errors and how to resolve them.

Creating a Problem Report

If any unexpected or unresolvable issues occur, detailed logging information is available that can assist
in troubleshooting.
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B Obtaining Documentation and Submitting a Service Request

Step 1

Step 2
Step 3
Step 4

To Create a Problem Report

Locate your IBM Lotus Sametime logs files:

a. From the File menu, select Preferences.

b. Open the Cisco tab on the left.

c. Under Cisco, select the Voicemail tab.

The Logs field shows the location of the IBM Lotus Sametime logs.

On the preference page, check the Enable Detailed Logging check box.

Reproduce the problem, then select Create Problem Report to collect the log files.
When prompted, enter the directory in which you want the problem report saved.

At this location, the problem report will be saved with a filename in the following format:

ProblemReport_Voicemail_<version>_<user ID>_<timestamp>.zip

User Unable to Play Voice Messages Because of Port Conflicts

If a user is unable to play a voice message and receives an “Error attempting to play voicemail” or
“Unable to instantiate Audio Player” message, check the trace-log-0.xml file log file.

If the log file shows a bind exception, then the Voicemail Port may be in use by another plug-in.

To resolve this problem, change the Voice Chat Port number from the Sametime Administration Console
on the Sametime server. For steps on how to change this port, refer to the Sametime Administrator Guide.

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS Version 2.0.

Cisco and the Cisco Logo are trademarks of Cisco Systems, Inc. and/or its affiliates in the U.S. and other countries. A listing of Cisco's trademarks
can be found at www.cisco.com/go/trademarks. Third party trademarks mentioned are the property of their respective owners. The use of the word
partner does not imply a partnership relationship between Cisco and any other company. (1005R)

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and
figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and
coincidental.

© 2010 Cisco Systems, Inc. All rights reserved.

r Release Notes for Cisco Unified Messaging Release 8.0(1) with IBM Lotus Sametime


http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
http://www.cisco.com/go/trademarks

	Release Notes for Cisco Unified Messaging Release 8.0(1) with IBM Lotus Sametime
	Contents
	Introduction
	System Requirements
	Compatibility Information
	Determining the Software Version

	Related Documentation
	New and Changed Requirements and Support-Release 8.0(1)
	Cisco Unified Messaging Systems
	IBM Lotus Client Applications
	Operating Systems on User Workstations

	New and Changed Functionality-Release 8.0(1)
	Installation and Upgrade Information
	Downloading Cisco Unified Messaging 8.0(1) with IBM Lotus Sametime Software
	Applying IBM Hotfixes for Lotus Sametime 8.0.1., 8.0.2, or 8.5 (Secure Messaging Only)
	Upgrading to Cisco Unified Messaging 8.0(1) with IBM Lotus Sametime
	Installing Cisco Unified Messaging 8.0(1) with IBM Lotus Sametime
	Configuring Cisco Unified Messaging 8.0(1) with IBM Lotus Sametime

	Limitations and Restrictions
	IBM Lotus Notes Displays Dates In U.S. English Format
	IBM Lotus Sametime Displays Dates In U.S. English Format
	G.729a Encoded Voice Messages Cannot Be Played
	MWI on Phone Does Not Change to Reflect Message State
	Deleted Messages Folder Is Not Supported If the Mail Store Does Not Support UIDPLUS
	Update Sites

	Caveats
	Troubleshooting Information
	Status Bar in Cisco Voicemail Application Panel
	Creating a Problem Report
	User Unable to Play Voice Messages Because of Port Conflicts

	Obtaining Documentation and Submitting a Service Request



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


